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MODULE 1: WORKING WITH COMPUTERS 

1.1. General introduction to computer 

1.1.1. Definition 

A computer is an electronic device, operating under the control of instructions stored in its own memory 

that can accept data (input), process the data according to specified rules (Control Processing Unit), 

produce information (output), and store the information for future use (Internally or externally). Any kind 

of computer consists of HARDWARE (collection of physical elements that constitutes a computer system) 

AND SOFTWARE (set of instructions, data or programs used to operate computers and execute specific 

tasks). 

Computer systems consist of three components as shown in below image: Central Processing Unit, input 
devices and Output devices, which processes data and generates useful information that is displayed to 
the user through output devices. 

 

1.1.2. Types of Computers 

Computer types depend on data handling capabilities or the physical appearance. The table below shows 
the physical appearance of some of the different existing types of computer and size: 

Type Illustration 

1. Desktop Computer 

A computer designed to fit 

comfortably on top of a desk, 

typically with the monitor sitting on 

top of the computer 
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2. Laptop 

A small, portable computer -- small 

enough that it can sit on your lap 

 

 

3. Tablet / iPad 

A computer that is intermediate in 

size between a laptop computer and 

a smartphone. 

 

4. Smart phone  

A smartphone is a portable 

computer device that 

combines mobile telephone 

and computing functions into 

one unit 

 

 

1.2. Hardware 

Computer hardware is the physical components that a computer system requires to function. It 

encompasses everything with a circuit board that operates within a PC or laptop, including the 

motherboard, graphics card, CPU (Central Processing Unit), ventilation fans, webcam, power supply, and 

so on. 
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1.2.1 Computer peripherals  

A peripheral or peripheral device is an auxiliary device used to put information into and get information 

out of a computer. Peripherals are commonly divided into three kinds: input devices, output devices, and 

storage devices 

a) Input devices: 

An input device is something you connect to a computer that sends information/data into the computer. 

Examples of input devices 

# Device Image Details 

1 Keyboard  

 

 

It is used to enter characters and functions 

into the computer system by pressing 

buttons, or keys. It is the primary device 

used to enter text. A keyboard typically 

contains keys for individual letters, 

numbers, and special characters, as well as 

keys for specific functions. 

2 Mouse  

 

 

A mouse is a small hardware input device 

used by hand. It controls the movement of 

the cursor on the computer screen and 

allows users to move and select folders, 

text, files, and icons on a computer. 

Some are wired, others are connected 

without wire (wireless). 

b) Output device 

https://www.merriam-webster.com/dictionary/Peripherals
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An output device is any piece of computer hardware equipment, 

which converts information into a human-perceptible form. The 

main computer output device is a monitor or screen, which displays 

computer information like video images and text. 

Other output devices will be highlighted into the list of peripherals.  

c)  Storage devices  

Storage is a mechanism that enables a computer to retain data, either temporarily or permanently. 
Storage devices such as flash drives and hard disks are a fundamental component of most digital devices 
since they allow users to preserve all kinds of information such as videos, documents, pictures and raw 
data. 

Examples:  

 

Additional examples of computer peripherals 

# Peripherals Details 

1 Scanner 

 

The scanner uses the pictures and pages of text as 

input. It scans the picture or a document. The scanned 

Picture or document is then converted into a digital 

format or file and is displayed on the screen as an 

output. 

2 Printer A printer is a device that accepts text and images 

output from a computer and transfers the information 

to paper. 
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3 Projector 

 

 
 

A projector is an optical device that projects the 

computer content onto a surface, commonly a 

projection screen 

4 Webcam 

  

 

  

 

 

A webcam is a video device which is designed to 

record the pictures or movies. For the laptops it is 

commonly built into a computer. For the desktop, it 

will be plugged as external device  
Inbuilt 
camera 

 
Separate camera 

which can be 
added (or 

connected) to 
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5 Speakers 

 

A computer speaker is an output hardware device that 

connects to a computer to generate sound.  

6 USB Flash Drive 

 

A USB flash drive is a portable data storage device 

that includes flash memory with an integrated USB 

interface. It is typically removable, rewritable, and 

small. It is measured into Gigabits. 

The USB (Universal Serial Bus) port on the computer, 

is used also for Modems, Printer and other devices 

plugin. 

7 Power cord 

  

Power cords are a vital part of any computer, whether 

it is a laptop or a desktop. The desktop needs the 

power cord to work. A laptop can run on batteries for 

a limited amount of time, but then needs the power 

cord for recharging. 
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1.2.2 Computer ports 

In computer hardware, a port serves as an interface between the computer and other computers or 

peripheral devices. In computer terms, a port generally refers to the part of a computing device available 

for connection to peripherals such as input and output devices. 

Desktop Computer ports 

Legacy ports: For mouse and keyboard, but 

for the new computers those ports are no 

longer used. 

Monitor: to connect VGA cable for 

monitor/screen 

Firewire: It can transfer a large amount of 

data at a very high speed 

USB: For connecting flash disks and other 

devices with USB terminal 

 

 

Laptop Computer ports 
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1.2.3. Identifying and addressing hardware issues 

Examples of hardware issues 

# Hardware fault Action 

1 Keyboard Problems: 

stuck keys, broken keyboards, keyboards that 

will not connect to the computer or keyboards 

where the letters end up jumbled. 

- Unplug and plug it again 

- Report if to IT repair 

- Or purchase a new one 

2 Mouse Problems: 
freezing on the screen, connection problems, 

failure to move or damage to the mouse.  a 

wireless mouse that freezes might need a 

battery change, while a wired mouse that 

freezes will need repairs or replacement. 

- Unplug and plug in again 

- Restart the computer 

- For wireless mouse, try to change 

battery 

- Report to IT repair 

- Or purchase a new one 

3 Power Cord Problems: 
Power cords are a vital part of any computer, 

whether it is a laptop or a desktop. The desktop 

needs the power cord to work.  A laptop can 

run on batteries for a limited amount of time, 

but then needs the power cord for recharging. 

The cable may not charge the computer 

- Check along the entire length of 
the cord to ensure it is well 
plugged-in. 

- For Laptop adaptors, report to IT 
repair or replace the cord. 

1.2.4. Start up and shut down a computer  

a) Start a computer system/ Turn on your computer 

Whether you want use a laptop or a desktop computer, you need to start the computer first. To do so, 

you will have to locate the switch button on your device and follow the steps below: 
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Steps to turn on your computer: 

1. Locate the power button on the computer which may display the icon below: 

                    

2. Press the power button once. 

3. You should see the computer lights turn on. 

4. The computer will now go through several processes to power on, these include several tests to 

ensure each part of the system is functioning correctly. 

5. Once the initial startup processes have completed, and this may take a minute or two, you should 

now see a screen displayed with the date and time. 

b) Shut down the computer 

When you are done using the computer, it is a good practice to shut down your computer. This gives the 

computer system a break and allows all components to cool down completely. This will also save energy 

consumption. 

To shut down the computer: 
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1. Click the Start menu 

2. Click the Power icon 

 

3. Choose Shut down 

 

4. The computer will now shut down. 

 

1.3. Software 

Computer Software is a set of instructions, data or programs used to operate computers and execute 
specific tasks. Computer software are mainly divided into three types: 

System software / Operating systems: is a type of computer program that is designed to run a computer's 
hardware and application programs. Example: Windows, mac OS, Android and iOS  

Utility software: is a type of program that is designed to run in the background like security and 
optimization programs. Example: Antivirus  

Application software: is a computer program designed to carry out a specific task typically to be used 

by end-users. Example: Microsoft products such as Office, PowerPoint, Word, Excel; Internet browsers 

like Chrome, Safari, and Firefox; and Music Application Software.  
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1.3.1. Application software installation 

Today, the most common way to get new software is to download it from the Internet. Some are free 

applications others are commercial. For example, if you wanted to install the Google Chrome web 

browser, you can visit this page  (https://www.google.com/chrome/) and click the Download button. Or 

if you want to download VLC for video player, visit this page (https://filehippo.com/download_vlc-

media-player-64/) and click the Download button. 

The installation file will be saved to your computer in “.exe” format. Pronounced dot e-x-e, this is the 

standard extension for installation files on Windows computers. You can follow the steps below to install 

an application from an .exe file. 

1. Locate and download an .exe file. 

 

2. Locate and double-click the .exe file. (It will usually be in 

your Downloads folder.) 

https://www.google.com/chrome/browser
https://www.google.com/chrome/
https://filehippo.com/download_vlc-media-player-64/
https://filehippo.com/download_vlc-media-player-64/
https://filehippo.com/download_vlc-media-player-64/
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3. A dialog box will appear. Follow the instructions to install the software. 

 

4. The software will be installed. You can now open the application from the Start 

menu (Windows 7) or the Start Screen (Windows 8) 

1.3.2.  Protecting computer with password  

If you are using a PC or laptop for your own needs only, it is always advisable to password protect it. Each 
person has personal files, including documents, videos, photos, banking credentials, etc. that should not 
be viewed or used by other people. Therefore, experts highly recommend password protecting the PC. 

For a computer with Windows 10, here are the steps to password protect Local User Account: 

1. Search for Control Panel and click on Change account type 
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1. Select a user account. 

 

2. Choose Create a password. 
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3. Enter a new password, re-enter it, type password hint and click Create password. 

 

 

 

 

1.4 Practices 

 

 

 

 

 

 

 

 

 

Activity 1 

Question 1: Can you tell the difference between a simple calculator and a computer? 

Question 2: Explain the difference between a simple calculator and a computer? 

Question 3: Name the computer components illustrated by the numbers 

 

Question 4: List the usage of computer in teaching activities 
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Question 5: The most frequently used output device is the:  

a. Scanner, b. Monitor, c. Mouse, d. Digital Camera  

Hint: b 

Question 6:  Devices such the keyboard, scanner and microphones are known as:  

a. Input, b. Output, c. Processing, d. Storage 

Hint: a 

Question 7: Which of the following is not an output device? 

 a. Speakers, b. Monitors, c. Scanner, d. Disk drive 

Hint: c  

Question 8: What is the difference between operating system with an application software? 

Question 9: List 4 names of Desktop Operating systems. 

Question 10: Investigate your environment and find out which operating systems are being 
used by people surrounding you. If possible, discuss and share the experiences of various users 
who are using different Operating Systems. 
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MODULE 2: CREATE DIGITAL CONTENT WITH WORD PROCESSING  

Word Processing commonly known as MS Word in windows is one of the programs of MS Office which 
aims to help computer users in creating text documents. MS Office is produced in several versions targeted 
towards different end-users and computing environments. 

This module of word processing aims at helping in service primary teachers to digitalize their 
pedagogical documents.  

This module will be focused on: 

• Exploring Microsoft Word 

• Formatting text  

• Practices  

2.1. Exploring Microsoft word 

2.1.1. Creating and saving document in alternative File Formats step by step 

a) Creating new document  

Step 1: Click on Start button on the taskbar or typing Word in search Menu. The MS word appears   
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Step 2: We will use word 2016 as the office installed if office 2016 version, and there are different 

versions of office, you can choose the one to use depending on your choice. 

 

Step 3: To create a new blank document, Click the Microsoft Office button. The blank Document dialog 

box appears. Select Blank document under the Blank and recent section. It will be highlighted by default.  
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b) The MS Word user interface 

 

1. Quick access toolbar  

2. Tabs  

3. Ribbon  

c) Saving a document  
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Backstage view provides a range of options that are used to manage and print documents; for example, 

view and edit document properties, and open, save, print and share documents. 

• Save As - allows file name, file type, and location to be specified and is used to save a newly created 

document, or to save another copy of a previously saved document.  

• Save - allows you to save/update changes to a document. 

d) Saving a document in alternative file formats in a created folder  

 

1. Folder location 

2. Created folder 

3. Rename file document 

4. All file format  
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2.1.2 Text editing  

In this section, you will learn about to change the appearance of your text in a desired format through the 
following steps:  

a) Selection of text  

Use the following to select, a word, a sentence, a text or a paragraph 

• Quickly double-click that word, to select a single word. 

• Press Ctrl + Shift + down arrow on your keyboard, to select a paragraph, place your 
cursor at the start of the paragraph,  

• and press [Shift]+ down arrow, to move one character or one line at a time, hold down 
the [Shift] key while pressing the right and left arrow keys and the up and down arrow 
keys, respectively. 

• Triple-click: A triple-click selects the current paragraph. 

•  Ctrl+A: selects the entire document. 

• Ctrl+click: To select a sentence (not just a line), hold down [Ctrl] and click any place 
within the sentence. 

•  Ctrl + Shift + Right arrow | Left arrow: Use this combination to select from the current 
position to the right or left of the current word, depending on whether you press the right or 
left arrow, respectively. 

 
b) Editing text in a document  

In Microsoft Word, you can edit text using either “Insert mode” or “Overtype mode”:  

• Insert mode is the default way of entering text. In this mode, the text you type is inserted at the insertion 
point.  

• Overtype mode, existing text to the right of the insertion point is replaced as you type. 

c) Deleting text  

To delete single characters or text, you use the [Backspace] or [Delete] key. The Backspace key deletes 
the character or text to the left of the insertion pointer. The Delete key deletes the character or text to the 
right of the insertion pointer. 
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d) Copying, moving/pasting text  

• Cut-Paste: will remove the original content from the document and place it in a new 

• Copy-Paste: inserts the content to a new location without removing the original content. 

e) Using undo, redo and repeat  

 

f) Find and replace a text 

 

Go through the following steps to replace a document: 

1. Go to Home then click on Replace. 
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The following will appear 

 

2. Enter the word or phrase you want to replace in Find what. 
3. Enter your new text in Replace with. 
4. Click Replace All to change all occurrences of the word or phrase. Or, select Find Next until you 

find the one you want to update, and then click Replace. 

2.1.3 Text Formatting 

Text formatting allows your documents to appear more professional. You can format text in Microsoft 
Word by changing font types, font size, and font style, including bold, italics, underline and color. The 
Font and the Paragraph groups on the Home tab allows you to format your selected text.  

a) Font groups formatting  

This group provides basic controls for font, style, and color settings of the selected text. Controls displayed 
on a context-sensitive basis: 

● Fonts    Select from the installed fonts by doing any of the following: 
− Click the arrow to drop down the list, then click on the desired font. 
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− Click in the text box and start to type the name of the desired font. Hit Enter on your 

keyboard to apply the selected font. 

● Size    Select or type the size of the text in Points. 

● Bold    Click to turn the text bold, or turn it back to non-bold. 

● Italic    Click to turn the text italic, or turn it back to non-italic. 

● Underline    Click to underline the selected text with the actual style (displayed on the button). 

− To change the style, click on the arrow to drop down the list of underline styles, and then 

select one. 

− To remove the underline, click the button again. 

● Strike-Through    Click to strike-through the selected text. Click again to remove strike-

through. 

● Superscript    Click to make the text superscript. Click again to remove superscript. 

● Subscript    Click to make the text subscript. Click again to remove subscripts. 

● Font Color    Click to color the selected text with the actual color (displayed on the button). 

b) Text formatting toolbar  

 

1.Font  2. Strike through 

 

3. Font size 

 

4. Grow Font  

 

5.Shrink Font  

 

6. Change case  

 

7. Clear all 

formatting 

8. Bold 9. Italic 10. Underline 

11.Subscript 12. Superscript 13. Text Effect and 

typography  

14. Text 

Highlight color  

15. Font color  
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c) Paragraph group Formatting  

Paragraph formatting refers to formatting commands that affect entire paragraphs – settings such as 
indenting, bullets, line spacing and paragraph spacing. To understand paragraph formatting and how it 
works, you need to understand what a paragraph is. 

In this section, you will learn about:  

• Creating and merging paragraphs  

• Aligning paragraphs  

• Aligning text with click and type  

• Paragraph spacing  

• Line spacing  

• Applying border/shading to paragraph/text 

• Copying paragraph formats 

Paragraph group Formatting icons 
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1.Align Center  

 

2. Align Right  

 

3. Justify   

 

4.Line and 

Paragraph Spacing   

5. Shading 

6. Borders 7.Show or Hide 

Marks  

8.Sort  

 

9.Increase Indent  

 

10.Decrease Indent  

 

11.Multilevel List   12.Numbering  13. Bullets  14.Align Left   

 
2.1.4 Equation and special characters   

 
a) Insert a special character   

A special character is a character that is not an alphabetic or numeric character. Punctuation marks and 
other symbols are examples of special characters. 

Steps to insert special character: 

Go to Insert > Symbol > More Symbols.  

The following dialog box will appear on the screen in which select the character that you want to insert. 

 

https://www.computerhope.com/jargon/c/charact.htm
https://www.computerhope.com/jargon/a/alphabetic.htm
https://www.computerhope.com/jargon/n/numeric.htm
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Steps to insert special character: 

Go to Insert > Symbol > More Symbols> Special Characters 

 

Double-click the character that you want to insert. Select Close. The special character is inserted into 
your text. 

b) Inserting equation 

Steps to inserting equation: 

i. Place cursor in the document where you want to insert an equation 

ii. Go to Insert tab in the Ribbon, click on the Equation drop-down icon in 

the Symbols section at the top right corner of the screen. 

iii. The following dialog box will appear on the screen in which select the equation 

that you want to insert. 



31 
 

 

 

 

2.1.5 Insert table  

Steps  

Click on Insert tab > Table > Insert Table. 

Table can be inserted in three ways  

⮚ Insert table by using grid.  

⮚ Insert table by filling rows and columns number.  

⮚ Insert table by drawing a table. 

    

1.2.6 Insert picture  

Click on Insert tab > Pictures  
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Browse the picture file from your computer 

 

1.2.7 Insert shape 

Click Insert, click Shapes, select a shape, and then click and drag to draw the shape. After you add one 

or more shapes, you can right click to choose add a text.   
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1.2.8 Insert page number  

Click on the Insert tab, click the Page Number icon, and then click Page Number. Select a location, 

and then pick an alignment style. Word automatically numbers every page, except designated title pages. 

To change the numbering style, select Format and then choose the formatting you want to use. 

 

1.2.9 Page background  

The Design Tab includes document formatting and Page Background. But in the module, we focused on 

Page Background which includes watermark, Page color and page borders. 
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a) Watermark  

Insert a watermark step by step 

⮚ On the Design tab, select Watermark. 

⮚ Choose a pre-configured watermark, like DRAFT, CONFIDENTIAL, or DO NOT COPY. 

⮚ For placing a logo or image, Select Watermark > Custom Watermark > Picture watermark > 

Select Picture. On the same menu you can create a custom text watermark. 

Insert a text watermark 

 

1. The following window will appear on the screen. Click on the Custom Watermark option. 
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2. The following window will appear on the screen. Click on the Custom Watermark option. 

A Printed watermark dialog box will appear on the screen. Click on the Text watermark radio button and 

do the following: 

Click on the Language: Select the language from the drop-down menu for the Watermark. 

Text: Type the text that you want to insert in the document as a watermark. 

Font: Click on the drop-down menu associated with the font to select the font that you want to add 

Watermark. 

Size: Select the size for the Watermark. 

Color: Select the color of the text that you want to add to the Watermark. 

Layout: click on either Diagonal or Horizontal layout for the Watermark. 
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Insert a picture watermark 

Microsoft Word not only allows you to insert Watermark inside the text, but you also insert watermark in 

the form of an image. An image Watermark can be a logo of a company or a simple attractive image. 

You can use below-mentioned steps to insert a picture watermark: 

Step 1: Go to the page layout tab and click on the Watermark option. 

Step 2: A window appears on the screen in which click on the Custom Watermark. 

Step3: A Printed Watermark dialog box will appear on the screen. Click on the Picture watermark radio 

button, click on the Select Picture button to browse the image that you want to insert and click on 

the OK button at the bottom of the screen. 
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b) Page color 

Go to Design > Page Color. Choose the color you want under Theme Colors or Standard Colors. If 

you don't see the color you want, select More Colors, and then choose a color from the Colors box. 
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Select the Design tab in the ribbon. 

 

● Select the Page Color button in the Page Background group. 

 

● Choose a color from the drop-down menu. 
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 (Alternative) Select More Colors in the Page Color menu, and then choose advanced color options 

from the Colors dialog box. 

 

⮚ After making your choice, your page background color should change immediately. 

⮚ If you want to remove the page background color, reselect the Page Color button and then 

select No Color from the drop-down menu  

c) Page borders  

Add a page border in Word document 

1. Go to the Page Layout tab and click on the Page Borders in the Page Background box. 
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2. A Borders and Shading window will appear on the screen 

 

3. Select the Shadow option to give shade around your page. 

o Select a line, from the style section that you want to add as a line border of your page. 

o Choose the color that you want to add on the border. 

o Define the width of the border using the Width drop-down menu. 

o Click on the Apply to drop-down menu to select the page and document in which you want to 

apply a border. 

o Click on the OK button at the bottom of the screen. 
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Instead of lines, you can also add designed shapes in the border. To add design, click on the Art drop-

down menu and select the border design that you want to add on the page. 
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1.2.10 Layout Tab Menu 

Page setup  

The Page Layout Tab holds all the options that allow you to arrange your document pages just the 

way you want them. You can set margins, apply themes, control of page orientation and size, add 

sections and line breaks, display line numbers, and set paragraphs. But this module focused on control of 

page orientation and Text column  

a) Page orientation steps 

Layout > Page Setup dialog box launcher. In the Page Setup box, under Orientation, click Portrait or 

Landscape. 

Portrait format refers to a vertical orientation or a format which is taller than it is wide. 

Landscape format refers to a horizontal orientation or format which is wider than it is taller 
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b) Text column  

To add columns to a document: 

1. Select the text you want to format. 

2. Select the Layout tab, then click the Columns command. A drop-down menu will 

appear. 

3. Select the number of columns you want to create. 
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4. The text will format into columns. 

List of basic computer shortcut keys 

Alt + F File menu options in the current program. 

Alt + E Edits options in the current program. 

F1 Universal help (for any sort of program). 

Ctrl + A Selects all text. 

Ctrl + X Cut the selected item. 

Ctrl + Del Cut selected items. 

Ctrl + C Copy the selected item. 

Ctrl + Ins Copy the selected item. 

Ctrl + V Paste the selected item. 

End Go to the end of the current line. 
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Ctrl + End Go to the end of a document. 

Ctrl + (Left arrow) Move one word to the left at a time. 

Ctrl + (Right arrow) Move one word to the right at a time. 
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1.3 PRACTICE  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Activity2: 

In the sixteenth century, an age of great marine and terrestrial exploration, Ferdinand Magellan led the 

first expedition to sail around the world. As a young Portuguese noble, he served the king of Portugal, 

but he became involved in the quagmire of political intrigue at court and lost the king's favor. After he 

was dismissed from service to the king of Portugal, he offered to serve the future Emperor Charles V of 

Spain.  

A papal decree of 1493 had assigned all land in the New World west of 50 degrees W longitude to Spain 

and all the land east of that line to Portugal. Magellan offered to prove that the East Indies fell under 

Spanish authority. On September 20, 1519, Magellan set sail from Spain with five ships. More than a 

year later, one of these ships was exploring the topography of South America in search of a water route 

across the continent. This ship sank, but the remaining four ships searched along the southern peninsula 

of South America. Finally, they found the passage they sought near a latitude of 50 degrees S. Magellan 

named this passage the Strait of All Saints, but today we know it as the Strait of Magellan. 

QUESTIONS 

From the below two paragraph, do the following  

Create a folder on Desktop and name it, Your full name  

Copy and paste the two above paragraph in blank document of word to save it in created 

folder with your full name 

Bold the second paragraph and change font of 1st paragraph to bookman old font 

Put yellow color as the background page color  

Put title of the document in Bold 

Save your work in created folder  
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MODULE 3: CREATE DIGITAL CONTENT WITH SPREADSHEET 

3.1. Exploring spreadsheet  

Spreadsheet or Microsoft Excel in windows devices is a general-purpose program used to organize, 

calculate, and analyze data. 

This program performs numerous functions and formulas to assist the users in their projects. 

3.1.1. Working with MS Excel 

a. Starting MS Excel 
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b. Components of excel file 

When the blank workbook icon is clicked, the new workbook will appear as shown in the below interface. 

 

Excel file is called workbook in which we can create numerous worksheets depending on the task. 
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Every worksheet is made up of thousands of rectangles, which are called cells.  

A cell is the intersection of a row and a column—in other words, where a row and column meet. 

Columns are identified by letters (A, B, C, D, E, F, ...), while rows are identified by numbers (1, 2, 3,4 

,5, 6, ...). Each cell has its own name or cell address basing on its column and row. In the above example, 

indicated cell intersects column I and row 4 to make cell I4. 

Note that the cells in your spreadsheet should each contain one piece of data. 

 

c. Cell splitting and cells merging 

In your worksheet, you will sometimes face a situation where you will need to merge or split the cells 

according to your needs. 

When the content to enter in a cell is bigger than the size of a cell, you can either split the cell which 

means increasing the size of a cell or you can merge the range of cells which means combining different 

cells. 

⮚ Steps to merge selected cells 

1. Select two or more adjacent cells you want to merge. 

2. Click at Home menu and click at Merge and Center if you want the content to be in center  
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3. If you want to merge cells without centering, click the arrow next to Merge & Center. Then 

click Merge Across, or Merge Cells 

 

3.1.2. Managing Worksheets 

Any information you enter into a spreadsheet will be stored in a cell. Each cell can contain different types 

of content, including text, numbers, formulas, and functions. 

a. Setting Worksheet Margins 

 To set worksheet margins in your worksheet  

1. Click the PAGE LAYOUT tab. 

2. Choose the margin format from the given list and you can even customize yours 
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b. Setting Worksheet Orientation 

The worksheet can be set in portrait or landscape. To choose the one of your choice you must follow the 

below steps. 

1. Click the Page Layout tab. 

2. Click the down arrow of the Orientation button 

3. Select one of your choice 

 

c. Scaling your Worksheet to fit the Pages 

 To scale your worksheet to fit the desired pages the below steps are recommended 

1. On the Page Layout tab, click the down arrow of the Width button in the Scale to Fit group. 

2. Select pages of your choice from the dropdown arrow at width 

 

3. Select pages of your choice from the dropdown arrow at height 
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3.2. Data manipulation and organization 

Microsoft Excel program is a widely used tool for data entry, storage, analysis, and visualization. 

This topic in this module aims to introduce the use of formulas and functions in spreadsheets, data sorting 

and the use of charts. 

3.2.1. Use of formulas and functions 

In MS Excel or spreadsheet programs, the formula is a mathematical expression that computes the value 

of the range of given cells while functions are predefined formulas that are already in Excel. 

a. Basic Formulas 

Excel formulas allow you to identify relationships between values in your spreadsheet’s cells, perform 

mathematical calculations with those values, and return the resulting value in the cell of your choice.  

When you write formulas in Excel, you must begin with an equal sign (=) because the cell contains, or is 

equal to, the formula and its value. 

Some of the mathematical operators that can be used in a formula are listed in the following table: 

Operator Performs 

+ (plus sign) Addition 

- (minus sign) Subtraction 

* (asterisk) Multiplication 

/ (slash) Division 
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% (percent) Converts a number into a percentage  

 

For example 

 =A1+A2+A3 will return the sum of the cells range from cell A1 to cell A3 

⮚ Entering Formulas 

a. Enter data in cells 

b. Select the cell where the result will be displayed to make it the Active Cell. 

c. Type an equal sign (=) to begin the formula. 

d. Click on the first cell to be referenced in the formula 

e. Enter the operator 

f. Enter the next cell to be referenced in the formula 

g. Press on Enter key 
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b. Use of excel functions 

 Functions are predefined formulas that are already in Excel. Functions carry out specific calculations in a 

specific order based on the values specified as arguments or parameters.  

The below table is for some basic functions. 

Function Name Description 

Sum SUM Returns sum of  the given range of cells  

Average AVERAGE Returns average of the given range of cells 

Minimum MIN Returns the smallest value in the range of cells 

Maximum MAX Returns the largest value in the range of cells 

 

For example  

=AVERAGE (A1:A10) This function will return the mean value of the content from cells A1 through A10. 

⮚ Steps to using a function 

b. Enter data in cells 

c. Select the cell where the result will be displayed to make it the Active Cell. 

d. On the FORMULAS tab in the Functions Library group,  

 

e. Click the Insert Function button 
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f. Select the function of your choice from the list  

 

g. The Function Arguments dialog opens with function arguments selected with the cell ranges. 

 

h. Finally, click at OK to get the result in indicated cell 

3.2.2. Data sorting and filtering 

Sorting lets you put data in various sequences, such as alphabetical order or grouping all of the rows of 

data related while filtering creates a smaller subset of the data while hiding the rest of the dataset. 

In the Data tab, go to the Sort & Filter group. To sort values based on Excel's interpretation of the column. 

1.  Select data to be sorted 

2. Click the home menu  
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3. Click sort and filter menu at the top right corner  

4. Then choose A to Z for ascending order or Sort Z to A for descending order or choose custom 

sort to define your preference. 

 

3.3. Printing worksheets 
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3.4. PRACTICE 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Activity3: The following table shows the marks obtained from general test in one class 

Create a folder on desktop and name it ICT_DL 

Open MS Excel in your computer and enter data in the above table by 

starting from cell B2 

Save the file in your ICT_DL folder and name it Results of general 

test. 

Find the total marks of each student 

Arrange average marks in Ascending order 
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MODULE 4: CREATE DIGITAL CONTENT WITH PRESENTATION 

4.1: Exploring PowerPoint 

PowerPoint (PPT) is a powerful, easy-to-use presentation graphics software program which allows you to 

create professional-looking electronic slide shows. PPT is used to present information in an organized 

manner to an individual or group. You can easily create a presentation that will impress your audience 

and convey your message clearly and professionally. 

4.1.1 Create and manage presentation 

Power point is one component for Microsoft Office. 

From the list of installed programs into your computer, search where PowerPoint is located and click on 

it. 

Create a presentation 

 

1) Click on the File tab 

2) Click on New 

3) Select either a Blank 

Presentation, 

4) Double-click Blank 

Presentation to create a 

new presentation 

 

When you create a Blank Presentation in PowerPoint, the workspace opens in Normal view. 

Normal view is divided into three main areas: 
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1) Slide Pane - shows the full layout of a slide 

2) Thumbnails – shows slide thumbnails 

3) Notes Pane – used to input text relevant to a specific slide 

Other views include Slide Sorter view which shows thumbnails of the entire presentation and Slide Show 

view where you preview your presentation as your audience will see it. 

 

 

Entering Text on a 

Slide 

When you create a 

new presentation, 

the first slide to 

appear is a Title 

slide. It contains two 

placeholders: a title  
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placeholder and a 

subtitle placeholder. 

To add text, click 

within the 

placeholder and type 

 

4.1.2 Managing slides 

PowerPoint includes several different slide views, which are all useful for various tasks. The slide view 

commands are located in the bottom-right of the PowerPoint window. There are four main slide views. 

 

⮚ Normal view: This is the default view, where you create and edit slides. You can also move slides 

in the Slide Navigation pane on the left. 
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⮚ Slide sorter view: In this view, you'll see a thumbnail version of each slide. You can drag and drop 

slides to reorder them quickly. 

 

⮚ Slide show view: This is the view you'll use to present to an audience. This command will begin 

the presentation from the current slide. 
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To Add New Slides: 

1) Click on the Home tab 

2) Click on New Slide in the Slides group 

3) Choose a slide layout 

 

4.1.3 Formatting slide Text 

Text is an indispensable element, so you should know all there is to make it appealing and useful for your 

audience. 

Format options include: 

▪ Font Color - Choose a font color for your text. 
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▪ Numbering or Bullets - Create a list using numbers or bullets. 

▪ Add or Remove Columns - Add or remove columns in your text. 

▪ Text Direction - Change the direction of text. 

▪ Align Text - Connect your text to the top, middle, or bottom of a bounding box. 

▪ Align Left, Center, Align Right, or Justify - Align your text the way you want. 

▪ Increase List Level or Decrease List Level - Increase or decrease a list indent. 

To Format Text: 

1) Click within the placeholder 

2) Select the text to format 

3) Click on the Home tab 

4) Click on the formatting buttons in either the Font or Paragraph groups 

5) You can also use the Mini Tool Bar that appears when the text is selected 
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4.2. Adding special effects 

You can animate the text, pictures, shapes, tables, SmartArt graphics, and other objects in your PowerPoint 

presentation. Effects can make an object appear, disappear, or move. They can change an object's size or 

color. There's also a related video about animating text. 

4.2.1 Animate text and picture in slides 

In PowerPoint, you can animate text and objects like clip art, shapes, and pictures. Animation—or 

movement—on the slide can be used to draw the audience's attention to specific content or to make the 

slide easier to read. 

The four types of animations 

There are several animation effect you can choose from, and they are organized into four types. 

● Entrance: This controls how the object enters the slide. For example, with 

the Bounce animation the object will drop onto the slide and then bounce several 

times. 

 

● Emphasis: These animations occur while the object is on the slide, often triggered 

by a mouse click. For example, you can set an object to spin when you click the 

mouse. 
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● Exit: These control how the object exits the slide. For example, with 

the Fade animation the object will simply fade away. 

 

● Motion Paths: These are similar to Emphasis effects, except the object moves 

within the slide along a predetermined path, like a circle. 

 

To apply an animation to an object: 

1. Select the object you want to animate. 

2. On the Animations tab, click the More drop-down arrow in the Animation group. 
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3. A drop-down menu of animation effects will appear. Select the desired effect. 

 

4. The effect will apply to the object. The object will have a small number next to it 

to show that it has an animation. In the Slide pane, a star symbol also will appear 

next to the slide. 
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At the bottom of the menu, you can access additional effects. 

 

Effect options 

Some effects will have options you can change. For example, with the Fly In effect you can control which 

direction the object comes from. These options can be accessed from the Effect Options command in the 

Animation group. 
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To remove an animation: 

1. Select the small number located next to the animated object. 

 

2. Press the Delete key. The animation will be deleted. 

Animations are best used in moderation. Adding too many animations can make your presentation look 

unprofessional and can even be distracting to your audience. Consider using subtle animations, or not 

using them at all. 

Working with animations 

To add multiple animations to an object: 

If you select a new animation from the the menu in the Animation group, it will replace the object's current 

animation. However, you'll sometimes want to place more than one animation on an object, 
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like Entrance and Exit effects. To do this, you'll need to use the Add Animation command, which will 

allow you to keep your current animations while adding new ones. 

1. Select an object. 

2. Click the Animations tab. 

3. In the Advanced Animation group, click the Add Animation command to view the 

available animations. 

 

 

To reorder the animations: 
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To copy animations with the Animation Painter: 

In some cases, you may want to apply the same effects to more than one object. You can do this 

by copying the effects from one object to another using the Animation Painter. In our example, we want 

to copy an animation from one slide to another because they have similar layouts. 

 

2. From the Animations tab, click the Animation Painter command. 
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To preview animations: 

Any animation effects you have applied will show up when you play the slide show. However, you can 

also quickly preview the animations for the current slide without viewing the slide show. 

1. Navigate to the slide you want to preview. 
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When you preview the animations, all the effects will play through automatically. To test effects that are 

set to Start on Click, you will need to play the slide show. 

4.2.2 Slides transition 

Slide transitions are the animation-like effects that happen when you move from one slide to the next 

during a presentation. Add slide transitions to bring your PowerPoint presentation to life. 

1. Select the slide you want to add a transition to. 

2. Select the Transitions tab and choose a transition. Select a transition to see a preview. 

3. Select Effect Options to choose the direction and nature of the transition. 

Note: Not every transition has Effect Options. 

4. Select Preview to see what the transition looks like. 

5. To remove a transition, select Transitions > None. 
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4.2.3 Add audio and video content to slides 

While how you insert a movie or sound file is similar to inserting a picture (go to the Insert Ribbon and 

click on the Video or Audio icon) 

Here are the steps: 

 

Step 2. Navigate to the correct clip, and click the OK button. 

 

 

4.3. Preparing output 

By completing the preparation of your slides, the output will be presented to audience or will be printed 

on papers. 

4.3.1 Presenting the prepare slides to audience 

The purpose of PowerPoint is to act as a visual aid as a presenter goes along presenting their option, ideas, 

sales pitch, etc. 

Steps to present slides to audience 

Step 1: Connect your computer with projector 

Step 2: Open your PowerPoint file, show the slide to start with, click on Slide show icon 
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Step 3: Use your computer arrows to present the next slides 

4.3.2 Printing slides 

You can print the entire presentation, only print the selected slides, only print the current slide and or enter 

specific slides to print. 

Steps to print slides: 

Step 1: Click on the File tab 

Step 2: Click on Print 

Step 3: Choose the Printer connected 
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Step 4: Navigate Settings 

Under Settings click on Print All Slides and select one of the options to print: 

● Print All Slides – print entire presentation 

● Print Selection – only print the selected slides 

● Print Current Slide – only print the current slide 

● Custom Range – enter specific slides to print 

 

Step 5: Choose number of required copies 

Step 6: Click on Print  
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4.4. PRACTICE 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Activity 4 

 Practice on Presentation 

 

Discuss the importance of Power point program in teaching and learning and prepare at least 10 
slides to present in our audience 

With the first slide selected, apply a Push transition  

Change the Duration to 4.00. 

Use the Apply to All command to apply your changes to every slide. 

Using the Slide Show button at the bottom of your window, play your slideshow and 
make sure each slide should advance automatically. 

Introduce your school to public 

 

Create a Public presentation introducing your school to public in which  

You give the full address of it  

Describe ICT facilities available at your school, and mention how you want to 
improve them 

The presentation should contain animations and transitions 

The presentation should contain at least 2 pictures taken from your school 

Save the presentation on the desktop of your computer under DL_Your full name  
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MODULE 5: ACCESS INFORMATION ONLINE, COMMUNICATE ONLINE AND 

SOCIAL MEDIA IN WORKPLACE 

This module introduces the broad meaning and steps of communicating online, accessing online 

information and using different social media in our daily life. 

5.1 Access information online  

5.1.1 Connecting to the internet 

The Internet (or internet) is the global system of interconnected computer networks that uses the Internet 

protocol suite (TCP/IP) to communicate between networks and devices. It is a network of networks that 

consists of private, public, academic, business, and government networks of local to global scope, linked 

by a broad array of electronic, wireless, and optical networking technologies. The Internet carries a vast 

range of information resources and services, such as the inter-linked hypertext documents 

and applications of the World Wide Web (WWW), electronic mail, telephony, and file sharing. 

Once you've set up your computer, you may want to have Internet access so you can send and receive 

email, browse the Web, stream videos, and more. You may even want to set up a home wireless network, 

commonly known as Wi-Fi, so you can connect multiple devices to the Internet at the same time. 

Internet Connection means a connection provided by an Internet Service Provider that enables individual 

computers or other hardware components, either individually or registered within a Local Area Network, 

to exchange Data over the public Internet. Let’s now see how to manually add Wireless. 

 

https://en.wikipedia.org/wiki/Computer_network
https://en.wikipedia.org/wiki/Internet_protocol_suite
https://en.wikipedia.org/wiki/Internet_protocol_suite
https://en.wikipedia.org/wiki/Internetworking
https://en.wikipedia.org/wiki/Optical_networking
https://en.wikipedia.org/wiki/Hypertext
https://en.wikipedia.org/wiki/Web_application
https://en.wikipedia.org/wiki/World_Wide_Web
https://en.wikipedia.org/wiki/Email
https://en.wikipedia.org/wiki/Internet_telephony
https://en.wikipedia.org/wiki/File_sharing
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Now you are connected to the internet. 

5.1.2. Web browser 

A web browser (also referred to as an Internet browser or simply a browser) is application software for 

accessing the internet, it takes you anywhere on the internet. It retrieves information from other parts of 

the web and displays it on your desktop or mobile device. The information is transferred using the 

Hypertext Transfer Protocol, which defines how text, images and video are transmitted on the web. 

Here are an examples of web browsers: 
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Here down is what you get once your web browser is opened: 
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 5.1.3 Search engines 

A search engine is a website that allows users to look up information on the World Wide Web (WWW), 

part of the Internet. The search engine will achieve this by looking at many web pages to find matches to 

the user's search inputs. We can say that it is a web-based tool that enables users to locate information on 

the World Wide Web. Popular examples of search engines are Google, Yahoo!, Ask.com and MSN 

Search. 

For example, if you want to search Cell in Biology you can do this 

 

After pressing the Enter button on your keyboard you get different information, it is now up to you to 

choose which one best meets your search. 
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5.1.4 Searching information from different sources  

We need to search information from different sources because knowing the kinds of information in each 

category of sources will help us to choose the right kind of information to meet each of our information 

needs. Some of those needs are very particular, we may need sounds, videos, text, etc.. 
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5.2. Communicate online (Gmail account) 

Online communication refers to the ways in which individuals as well as computers can communicate 

with each other over a computer network, such as the Internet. These ways include: chat rooms and e-

mail. 

5.2.1. Create Gmail account 

Gmail is free to sign up for and use, and has no hidden fees. There is no limit to how many emails you 

can send or receive, the number of people you can contact, or how much time you can spend using it. 

Gmail has some features you can purchase, but they do not drastically change user experience. Let us now 

start by creating a Gmail account. 

Then after you will get this: 

 

You will be prompted with boxes to fill in information to complete the account creation. 
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Next step: 

 

Scroll down to agree with the terms and regulations. Then, click on the continue button to proceed. 
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You are now done with creating your Gmail account. 

 

5.2.2. Compose and send an email with attachment  

A process sends an email to a user and another process receives the email, by either sending a response to 

the sender, or writing it to a log in the console. This process contains Send Mail and Receive Mail 
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5.2.3. Read, reply and forward an email 

Reply all sends the new message to the original sender and all other recipients on the To and Cc lines. 

Attachments are not included. Forward allows you to type in a whole new set of recipients. Any 

attachments included in the original message are automatically included when you forward a message 

Here you can read the received email as shown below: 
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5.3. Social media in workplace (twitter and facebook) 

Social media can be a powerful communication tool for employees, helping them to collaborate, share 

ideas and solve problems. Research has shown that 82% of employees think that social media can improve 

work relationships and 60% believe social media support decision-making processes. 
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5.3.1. Twitter 
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Learning the Lingo  

Twitter has a language of its own. Here are the terms you need to know!  

▪ DM/Direct Message: A private note between two users on Twitter. The person receiving the 

message must follow the person sending it and the message is bound by the 140-character limit.  

▪ Follow: The act of connecting with someone on Twitter. People who have elected to follow you 

will see your tweets in their timeline. You are not obligated to follow people back and you have 

the ability to block followers (usually used only for spammers) from seeing your posts.  

▪ Following: Electing to see someone’s tweets in your own timeline. Follow people and companies 

that you’re interested in hearing from.  

▪ Handle: Your Twitter username is referred to as your handle, and is identified with the @ symbol. 

For example, Constant Contact’s handle is @constantcontact. The @ is used to refer to a specific 

person or company and link to that account on Twitter within a tweet.  

▪ Hashtag: Words preceded by a # sign (i.e., #ctctsocial) can be used to tie various tweets together 

and relate them to a topic, be it a conference, TV show, sporting event, or any happening or trend 
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of your choosing. Twitter automatically links all hashtags so users can search for other tweets 

using the same tag.  

▪ Lists: A way to combine select people you follow on Twitter into a smaller feed. A list can be 

made up of friends, competitors, people in the same state: anything you want. lists let you view a 

slice of your followers at a time and are a great way to focus on specific folks when you’re 

following a large number of people. They can also be marked as public or private. 

The first step in getting started on Twitter is creating your account. When creating your account, it’s 

important to remember that your username—or as it’s called on Twitter: your “handle,” is outward facing 

and will be what the public uses to identify your business. Hopefully, your business name will be available 

(Constant Contact’s handle for example is @ConstantContact,) but if not, you’ll want to come up with 

something that will still make sense to your followers (for example: “In a Pickle Restaurant” in Waltham 

had to use @InAPickleRest). 

 

Click next to reach in your twitter account 
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Profile and adjusting your privacy settings 

By default, everything you share on Twitter is public. This means anyone can see the things you tweet, 

even if they don't follow you on Twitter. However, if you want to control who can see your tweets, there's 

an easy option. Navigate to your profile page. If you're using the mobile app, locate and select 

the Gear icon. If you're using a desktop web browser, select the Profile icon near the upper-right corner, 

then choose Settings. 
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Who you follow on Twitter will dictate the type of content you have access to and the quality of the 

relationships you’re able to establish. For this reason, you’ll want to set up some criteria based on your 

experience, your industry, and what you’re trying to accomplish. People you may want to follow could 

include: friends, professionals in your industry, other local businesses, colleagues, and even current or 

potential customers.                                                                      
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Creating and post a tweet  
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Retweet is when you share a tweet without adding any comment or words to the actual tweet. Hence, 

keeping the original tweet and concept tweeted by the user. On the other hand, the re-sharing of the tweet 

with an added comment is called a Quote Tweet. 

 

5.3.2. Facebook 

Facebook is a website where you can connect with friends and family and share with others. You can post 

a wide variety of content, including text, photos, links, events, interactive polls and more. Shared content 

can be made publicly accessible, or it can be shared only among a select group of friends or family, or 

with a single person. 

To create a Facebook account 

Go to www.facebook.com (the Facebook homepage).  

▪ You will need to be at least 13 years old to create an account. Facebook accounts are free, and you 

should only create one.  
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▪ Fill in the “sign up” form. Enter your name, email or mobile phone number, password, date of 

birth and gender. You must use your real name for your account. Nicknames are allowed as long 

as they are a variation on your real name.   

▪ Click Sign Up. 

▪ Click the link in the email to activate your account.   

 

Setting up your profile 

To add a profile picture over the silhouette placeholder and click ‘update’. You can add a picture of 

anything you like, although ideally you should add a photo of yourself. 

Similar to adding a profile picture, you can also add a photo that displays above your profile. Hover over 

the blank space and click “Add Cover Photo”. 
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The way you connect with others on Facebook is by adding ‘friends. You can search for people by their 

name or email, import your contact lists, and invite friends that aren't currently using Facebook. When 

you find someone that you want to add, you will need to send a friend request. Once they accept your 

invitation, that person will be added to your Friends list. 
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A Facebook post or "status update" is a message that you post (share) on your Facebook. It can take the 

form of a comment, link, picture, video or other media and is ‘posted’ to your Personal Profile (your 

“Wall” or “Timeline”) and shows up in your Friends News Feed (depending on your privacy settings). It 

is one way of communicating with your friends and family on Facebook.   

 

If you're friends with someone, their posts will appear in your News Feed (on the homepage) and you can 

interact and engage with them. You can click “Comment” below a post they make and then type a 

comment to add below their original post. Any friends who see your content will see this post in their 

News Feed pages as well. 
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As well as ‘posts’ which are a means to communicate with all your friends in one go (depending on your 

privacy settings), private messages are a way to communicate with certain friends (or a group of friends) 

privately on Facebook. 

 

5.4. PRACTICE 

 

 

 

 

 

 

 

 

 Activity 5 : Do  the following tasks  to complete this activity  

After connecting your computer to available network /Wi-Fi, make a research on any topic from 

your teaching subject using any search engine. Create your own Gmail account and send the results 

found in a) to trainerse@gmail.com  as an attachment. Sign up for twitter   and follow REB twitter 

account, make sure you have followers and also customized profile with your picture. 

Create a Facebook account for yourself, find friends there after adding a cover and a profile 
picture. 

Visit REB YouTube channel and get at least two teaching /learning videos resources   that can 
support/help you in your daily teaching activities offline. 
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MODULE 6:  USE OF ONLINE LEARNING PLATFORMS 

An online learning platform is a portal for educational content and resources that offers a student or a 

teacher everything they need in one place: lectures, resources, opportunities to meet and chat with other 

students, and more. It is also an excellent way for the student and the teacher to monitor student progress. 

In this Module we shall see how to use REB e-Learning platform or learning management system (LMS) 

and REB YouTube channel to access different educational resources.  

6.1. Access REB learning management system through the web 

● Enter the address “https://elearning.reb.rw/” on the web search bar of any browser (chrome, 

opera, etc.) and press Enter 
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● The Home Page appears when you first access the system. 

 

6.1.1. Create an account  

• Click Create New Account Button  

 

● Select the user type (Teacher or Student) 
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● Click on Validate button at the bottom 

 

● Click the Create my new account button to finish the validation.  
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● Click continue  

 

 

• To access into the system and use it, the teacher will be required to login by providing his/her 

Identification number and Password. There are two ways to do so.  
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• The teacher will click the lock icon on the upper right and fill the fields then click login button 

 

1. Lock icon  

2. Sign in button  

 

• Click the sign in button  

• Click the Login button to use the system 

 

After Login into the portal, the Teacher Dashboard page will appear. The teachers Dashboard Contains 

various setting and contents. 
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6.1.2. Teacher Dashboard navigation  

 

B. When you click on Courses it will take you to a page that display all Courses Categories  

  

C. When you click on Library it will take you to resources from e-Library  
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D. When you click on CPD it will take you to different professional development courses  

 

E. When you click on E-mentorship it will take you to a forum to share and exchange knowledge and 

ideas 
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6.1.3. Accessing learning resources  

    Courses  

• Click on courses  

 

 

• Click on the Book to Download and read it  
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• Click on the download button to save the book on your device  

 

A. Download button  

B. Downloaded Kinyarwanda Book  
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6.1.4. Library  

• Click on Library  

 

• Click on the Subject  

 

 

b) Searching a book from search box  

 

• Click on library  
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• The book will be displayed  

 

c) Reading a Book from the e-Library  
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• Click library  

• Search the book  

• Click Read  

 

 

 

A. Click on finish reading to finish reading the book 
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B. Click on Download to download the book  

6.1.5. Sharing Ideas through E-mentorship 

a) Replying to a posted topic  

• Click e-mentorship  

• Click discuss to this topic  

• Type in the text box  

 

• Your post is seen by other teachers  

 

b) Posting a Topic  

• Click Add topic  
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• Type the message  

 

• Click post to forum 

 

6.2. REB YouTube channel  

YouTube is a popular video sharing website where registered users can upload and share videos 

with anyone able to access the site. These videos can also be embedded and shared on other sites. 

Rwanda Basic Education Board has chosen to create a YouTube channel in order to help teachers 

and student to access video lessons. Here below are some guiding steps to the REB e-learning 

channel.  

▪ Step 1 
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▪ Step 2 
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▪ Step 3 

 

▪ Step 4 

 

How to download YouTube videos on desktop 

Very recently, YouTube introduced the ability to let desktop browser users download videos for 

offline viewing. The Google-owned platform says the feature will only be supported in computers 

with the latest versions of Chrome, Edge, or Opera browsers. Unlike mobile, this feature is only 

https://gadgets360.com/entertainment/news/youtube-video-download-offline-web-browser-desktop-update-premium-subscription-2550920
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available to Premium users on desktop. To download a video on desktop, follow the simple steps 

below: 

1. Open YouTube on your browser. Ensure that your browser is updated to the latest version. 

3. Once the video is downloaded, you can find it in the hamburger menu in the left, in 

the Downloads section. 

4. To choose download quality, head to Settings > Downloads. YouTube Premium users can 

download up to full-HD (1080p) quality. 

 

6.3. PRACTICE 

 

 

 

 

 

Activity 6: Do the following tasks  to complete this activity : 

Activate your account on e-learning.icte.reb.rw as a teacher then navigate through 

until you have a teaching and learning resource that can be used once you are 

offline. 
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MODULE 7. CONTENT ACCESS POINT 
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  7.1. Introduction on CAP features 

A Content Access Point is a wireless access point with an integrated digital content e-learning platform, 

which provides an easy-to-use interface and storage unit that can be loaded with educational materials 

that students can access without requiring access to the Internet. 

7.1.1 CAP features 

Pre-loaded Content 

Content is pre-loaded allowing students and teacher access to connect quickly and easily. Teachers can 

also create and upload their own lesson plans. It is lightweight, portable and can easily be mounted to the 

wall with included hardware. The current preloaded content is based on the current textbooks used in 

primary schools. 

Flexible Connectivity 

The device offers multiple connection options and includes a battery providing up to 5 hours of 

continuous. 

Content Access Point - Top View Content Access Point - Bottom View 

 

 
 

1 System LED status 7 Micro SD slot 

2 3G/4G LTE LED status 8 Power plug 

3 Power button 9 WAN Ethernet Port 
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4 Factory reset button 10 WAN Ethernet LED status 

5 Wall – mount holes 11 WAN Ethernet activity status 

6 WI-FI MAC Address label   

 

Main CAP Ports

The device has four ports 

WAN Gigabit Ethernet 

USB 3.0 (USB 2.0 Compatible) 

Micro-SIM (Accessible by removing bottom cover) 

Micro CD  

   Device placement location 

✔ For the best signal put the Content Access 

Point: 

✔ In an open area 

✔ High off the floor 

✔ Away from the wall 

✔ Away from the magnetic and large metal 

object 

✔ At least one (1) meter from the client 

device
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7.1.2 CAP Setup 

1. Connect the power supply 2. Power up the device by pressing and holding 

the power button 

 
 

 

7. 2 How to access the system (content access point) 

7. 2. 1 Connect different devices to CAP  

1. Open your computer 

2. Go to network and sharing center 

3. Find WI-FI 

 

4. Among the displayed list of networks, choose “CMAL-5G” 
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5. Connect to 5G and wait for the browser to open.  

NB: The above indicated last four characters are not fixed; it will depend on mac address of the device 

(CAP). 

Redirect to browser: my Content (make sure in the address box of your favorite it is written my. 

Content /Moodle 
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After being connected on CMAL-5G-db9d the browser (Mozilla Firefox, google chrome, internet 

explorer…) will be opened automatically depending on what is default on your computer. When it is 

not opened automatically you can write in the address box my. Content or 192.168.1.1/Moodle. 

 

 

To connect to CAP using XO-Laptop 

i. Using Sugar Interface 

 

ii. Using gnome interface 

 

       7. 2. 2.  Log into CAP 

This step allows enrolled users to access the system through their own username and password and 

username and password must be personal. If you are not an admin, remember to login through the 

specific subject. 
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Note: For the first-time login, the default username is “admin” and Password is     *Admin1#. 

Click Log in or 

Press Enter key from the keyboard 

The content now opens and states whether the logged in user is an admin or not. 

The admin user is the one allowed to add users.   

  

Then 
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7. 3 Add and enroll users 

7. 3. 1 Add a new teacher 

The admin user has the right to add other users. New users being Teachers or Students are added 

through the Administration site as follow:  

 

 

Click Site administration, choose Users 

 

 From the displayed list Choose Add new user 
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The new user registration requires the following details: 

✔ Username, Password, First name, Surname 

✔ Email address (not necessary a working one) 

✔ The admin should use the easily remembered usernames and passwords. 

                        

 

 

     Scroll down and Click Create user 
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Note: once a teacher is added as new user, He / She is enrolled to a subject to have an access on it 

7. 3. 2 Enroll a teacher to a course 

For a teacher to access the content of a certain subject, to be enrolled on the subject is a prime 

requirement, and this is done by the admin user. To do this the steps are:  

1. Click the subject name from the list of courses displayed on the left side 

2. Under the displayed list of operations, choose Participants 

3. On the upright corner of the course content, click the Action button 

4. Click Enrolled users button and Choose Enroll users 

5. In front of the name of the user you want to enroll from the displayed list, Click Enroll 

Step 1. Click the subject name from the list of courses displayed on the left side 
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Step2. Under the displayed list of operations, choose Participants 

 

 Step 3. On the upright corner of the course content, click the Action button 
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Step 4.  Click Enrolled users button 

 

 Step 5. Click Enroll users 
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Step 6. In front of the name of name of the teacher you want to enroll, Click Enroll 

 

7. 3. 3 Add Students 

Requirement: 

✔ Complete first the excel sheet for students 

✔ Fill their username 

✔ First name 

✔ Last name 

✔ Email 

✔ Password 

✔ Courses 

✔ save as CSV format (MS-DOS)

 

The steps to add students are the following 

1. Click Site administrator  

2. Choose Users 

3. Click Upload users 

4. Choose Upload File 

5. Browse the file you save from its location  

6. Click Upload this file 

7. Click Upload user



129 
 

Step1. Click Site administration 

 

Step 2. Choose Users 

Step3. Click Upload users 
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Step 5. Choose file from its location 
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Step 6. Click Upload this file 

 

Step 7. Click Upload Users 
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A list of uploaded students displays for a preview. 
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7. 4. Adding a quiz 

7. 4. 1 Quiz setting 

For a course to which a teacher is having an access, He / She may also add an assignment or a quiz 

for the student to attempt. To do this a teacher: 

1. Opens the subject 

2. From the subject editing, Turns on 

editing  

3. Clicks Add an activity or resource 

4. Choose Quiz or Assignment  

5. Click the Add button 

6. Set the name of the quiz 

7. Schedule the quiz time 

8. Set the Pass mark 

9. State the number of attempts 

allowed 

10. Set the number of pages per 

questions 

11. Click Save and Display button 

 

Step 1. Opens the subject 
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Step 2. From the subject editing, Turn on editing  

 

Step 3.   Click Add an activity or resource 

 

Then after clicking on add an activity or resource the list of activities and resources it opens 
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Step 4. Choose Quiz  

 

 Step 6. Set the name of the quiz 

 

The setting allows you to make the assessment available for a set period of time. 
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Step 7. Stet the time of the quiz 
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The When time expires option (click 'show more' to see it) is used to determine how the quiz will behave 

if the time expires  

Step 8.  Set the pass mark and number of allowed attempts 

 



139 
 

Step 9. Set pages per question and save the work 

 

7. 4. 2 Add question to the quiz 

A quiz once it is uploaded, a teacher is still having the possibility to add some questions when needed by: 

1. Click on the quiz name 

2. Choose Edit quiz 

3. Click Add button 

4. Choose a new question 

5. Set the question category 

6. Type the question 

7. Click Add butt 
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7.5. Practice 

 

 

 

 

 

 

 

 

 

 

 

 

 

ACTIVITY 7 

Using administrator credentials, Login to CAP 

See and download SET P5 course, and save it on any location of your choice  

Register two users and enroll them to different subjects.  

E.g., Kalisa - Math P1 and Ntwali - SET P5 
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MODULE 8. INTRODUCTION TO OFFICE 365 

8.1 General overview  

Microsoft Office lets you create, share and collaborate all in one place with your favorite Microsoft apps all 

in one intuitive platform. Teachers and students get access to the best tools for learning anywhere in the 

classroom, remotely or in a blended environment for free, which empowers your students and teachers to 

achieve more. This all educators to: 

Access anywhere, anytime the provided apps and create equitable learning environments that help students 

to develop knowledge and skills essential for both academic and career success. 

Give the students tools to learn and collaborate on project together and independently, all in one place, to 

connect and achieve more together whether in classroom, at home or around the globe 

Academic goal 

 

Become more comfortable using Office 365. 

Learn how to use Office 365 tools to inspire, collaborate, engage, and 

communicate more effectively in the classroom. 

Learn how to enable both students and educators to experience more dynamic learning in the 

classroom 

Benefits of Office 356 in education? 

Office 365 is a staple set of tools for educators, it includes education specific functionality such as 

classroom notebooks in OneNote and educator-specific collaboration tools in Teams, assessment and 

communication tools.  

Microsoft O365 gives schools, teachers, and parents all the resources they need to move to a remote 

classroom with confidence. It is accessible on either mobile, tablet, PC or browser 
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8.2 Get started with office 365  

8.2.1 Log into Office 365 

Open your browser and navigate to: www.office.com 

Use your Microsoft account credentials (email and Password) to log in. 

Choose to stay signed in if you are using your device, and no if you are using other’s device 

  

 

http://www.office.com/
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8.2.2 Access some of office 365 Applications  

                     

All applications provided by the Office 365 platform are displayed under “All apps” button and are 

described with their full feature set. In this topic we shall discuss on OneDrive, Forms, Teams, OneNote 

and Outlook. 

 

 

Practical exercise: docs.microsoft.com/en-us/training/modules/what-is-m365/7-knowledge-check 

 

https://docs.microsoft.com/en-us/training/modules/what-is-m365/7-knowledge-check
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a. Microsoft OneDrive   

Use OneDrive to save documents, photos, and other files in the cloud, share them with friends, and even 

collaborate on content. When you subscribe to Microsoft 365, you get one Terabyte (1Tb) of storage and 

premium OneDrive features. OneDrive for work or school is online storage for your work or school 

organization. 

With OneDrive you can save work from any application to your cloud storage directly, without having 

to go to a website. That includes apps that autosave files. 

 

OneDrive main labels: Files or folders as created, uploaded, shared and deleted are grouped together as 

labeled and to create a file on OneDrive we pass through the New button. 
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To upload an already created document, we pass through the “Upload” button 
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Browse the file location to upload the file 

 

 

    



149 
 

Practical exercise: https://docs.microsoft.com/en-us/training/modules/m365-onedrive-collaboration-

use/summary-knowledge-check 

b. Microsoft Forms  

With Microsoft Forms, you can create surveys, quizzes, and polls, invite others to respond to it using 

almost any web browser or mobile device, see real-time results as they're submitted, use built-in analytics 

to evaluate responses, and export results to Excel for additional analysis or grading 

 

 

Educators create forms for either grading their students (quizzes) or only gathering information. These 

two feature are found as New Quiz or New Form 

    

https://docs.microsoft.com/en-us/training/modules/m365-onedrive-collaboration-use/summary-knowledge-check
https://docs.microsoft.com/en-us/training/modules/m365-onedrive-collaboration-use/summary-knowledge-check
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The opened Form comes with the following features 

1. Title of the form 

2. Questions area 

3. Edit form title 

4. Add new question button 

5. Responses area 

6. Form preview (Computer / Mobile) 

7. Set the them (Background of the form) 

8. Form general setting 

9. Share to respondents 

The Add New button allows to set a new question in difference categories: 
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Multiple choice question  

Text question 

Rating question 

Date question  

 

After all questions are set, the form creator may preview the form to see how it looks. He / She may also 

change the font of the form according to his / her wish. In addition to this, it is better to set the form general 

settings such as Who can fill the form, Options for responses, and Response receipts. 

As the form is created for receiving responses, it has to be shared to respondents to collect responses or to 

collaborators as well, through the   Share button. The link is copifed to be shared to respondents. 
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Once the link is shared and respondents have provided their answers, the response menu shows the number 

of submitted responses.  The form owner can view and download responses in   MS Excel 

 

 

 

1. Responses Menu 

2. Number of responses 

3. Form Average time to complete 

4. Form status (Active / Closed) 
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Practical Exercise: https://docs.microsoft.com/en-us/training/modules/create-authentic-assessments-

microsoft-forms/knowledge-check 

c. Microsoft Teams        

Microsoft Teams is a collaboration application built for hybrid work. You and your team stay informed, 

organized, and connected all in one place. Explore how Teams can help you and your colleagues come 

together no matter where you are: Chat / Message someone or a group to talk about work, projects, or just 

for fun. Microsoft Teams is a workspace for real-time collaboration and communication, meetings, file and 

app sharing, and all accessible to everyone. 

Teachers can easily communicate with students, host virtual learning webinars, host Team Meetings with 

unlimited pupils and store easily accessible files. Teachers can also collaborate and work alongside pupils 

on documents. 

How to open MS Teams? 

Log into Office 365 and click all apps button then choose Teams 

 

How to download and log into Teams 

1. Sign in to Microsoft 365. 
2. Select the menu button, and then select Teams. 
3. After Teams loads, select the settings menu in the upper-right corner, then select Download the 

desktop app. 
4. Save and run the downloaded file. 

 
 

https://docs.microsoft.com/en-us/training/modules/create-authentic-assessments-microsoft-forms/knowledge-check
https://docs.microsoft.com/en-us/training/modules/create-authentic-assessments-microsoft-forms/knowledge-check
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The app is being downloaded. Click on it to open 

     then     
 

      

 
Sign in with your Microsoft 365 email address and password. 
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MS Teams Menus 

 

1. Notification Tab: Shows all activities such as call, mentions, replies, etc 

2. Chart Tab: Allows to send and read the received messages.  

3. Teams Tab: Shows teams to which the user belongs and provides a way to join or create a team. 

4. Assignment tab: Allows to create assignments 

5. Calendar Tab: Allows to schedule new meeting 

How to schedule a meeting? 

MS Teams as a conference tool, allow to schedule a new meeting and invite participants. This is option is 

provided under Calendar Tab and follow steps:  
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1. Set the meeting 

2. Set the required participants (At least one of attendees) 

3. Set the starting date and time 

4. Set the ending date and time 

5. Add the meeting description if any 

Click send button 
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The new meeting is marked on the Teams calendar where the owner may click 

to copy the meeting link and share it to non-invited participants. 

 

 

Teams best practices 

 

1. See meeting attendees 

2. Meeting chatting room 

3. Raise your hand or other 

reactions 

4. Create breakout rooms 

5. Activate / Deactivate 

camera 

6. Mute / Unmute Microphone 

7. Share screen or 

content 

8. Leave the meeting if it 

ends 

Practical Exercise: https://docs.microsoft.com/en-us/training/modules/m365-teams-collab-manage-

teams/summary-knowledge-check 

 

https://docs.microsoft.com/en-us/training/modules/m365-teams-collab-manage-teams/summary-knowledge-check
https://docs.microsoft.com/en-us/training/modules/m365-teams-collab-manage-teams/summary-knowledge-check
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d. Microsoft OneNote  
 

OneNote is a digital notebook that automatically saves and syncs your notes as you work. Type 

information in your notebook or insert it from other apps and web pages. With OneNote we can organize 

documents into sections and pages, with easy navigation and search.  A OneNote document is organized 

into Sections and a section is made of several pages according to the wish of the user.

 

OneNote features  

 

 

1. Document title 

2. Add section 

button 

3. Add page button 

4. Text area 

5. OneNote tabs and 

toolbox bar 

(Ribbon) 
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Practical Exercise: 

 https://docs.microsoft.com/en-us/training/modules/get-started-with onenote/knowledge-check 

e. Microsoft Outlook  

Outlook organizes your emails, calendars, contacts, tasks, and to-do lists, all in one place. That organization 

starts with your email account. From there you can start working with emails, turning them into tasks or 

appointments, and storing information about the people you interact with in your contacts so that you never 

https://docs.microsoft.com/en-us/training/modules/get-started-with%20onenote/knowledge-check
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have to remember an email address or a phone number. Let’s take a quick walk-through of some basic 

tasks 

  To start outlook 

 

Create and send email 

1. Choose New Email to start a new message. 

2. Enter a name or email address in the To, Cc, or Bcc field. 

3. If you don't see Bcc, see Show, hide, and view the Bcc box. 

4. In Subject, type the subject of the email message. 

5. Place the cursor in the body of the email message, and then start typing. 

6. After typing your message, choose Send. 

https://support.microsoft.com/en-us/office/show-hide-and-view-the-bcc-blind-carbon-copy-field-04304e27-63a2-4276-8884-5077fba0e229
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To attach files 

 

Practical Exercise: https://docs.microsoft.com/en-us/training/modules/understand-actionable-messages/6-

knowledge-check 

8.3. Microsoft learn 

Microsoft Learn is a free, online training platform that provides interactive learning for Microsoft products 

with the goal of helping educators become proficient on technologies and learn more skills with fun, 

guided, hands-on, interactive content that's specific to their role and objectives. To discover Learn training 

paths type docs.mocrosoft.com into the browser address bar and explore the features.  

Steps to reach the site 

1. Open the browser of your computer / smartphone 

2. Into the address bar type docs.microsoft.com and press enter 

3. In the up-right corner Click Sign in 

4. Click Learn from the Menu bar 

5. Click Educator Center arrow and Choose Educator Programs 

6. Click Microsoft Educator (ME) after completion, then 

7. Click Microsoft Educator (ME) Trainer 

https://docs.microsoft.com/en-us/training/modules/understand-actionable-messages/6-knowledge-check
https://docs.microsoft.com/en-us/training/modules/understand-actionable-messages/6-knowledge-check
about:blank
about:blank
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The impact of teacher quality outweighs the impact of any other school education program or policy. In 

fact, teacher effectiveness is the largest factor influencing student outcomes, outside of family background. 

The professional growth pathway is designed to help teachers and school leaders everywhere become 

proficient in Microsoft technologies and learn more innovative classroom skills with fun, guided, hands-

on content that's specific to their role and goals. 

 

 

 Click Start Learning path for both ME and ME Trainer 
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 Read through the content and find answer to the knowledge check at the end of each 

course 

 To see your transcript, Click Profile and choose Achievements  
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8.4. Practice 

 

 

 

ACTIVITY 8 

Open the browser in your computer or smartphone or Tablet 

Navigate through Microsoft Learn and read the Microsoft Educator Academy Learning path 

Download your transcript and upload it to your MS OneDrive, to prepare a link to shared 
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MODULE 9: INTRODUCTION TO XO LAPTOP 

XO Laptop is a low cost laptop distributed to children in developing countries around the world, to provide 

them with access to knowledge, and opportunities to "explore, experiment and express themselves" 

The laptop is manufactured by Quanta Computer and developed by One Laptop per Child (OLPC), a non-

profit organization. 

The  XO Laptops use flash memory instead of a hard disk drive (HDD), and come with a pre-installed 

operating system derived from Fedora Linux, with the Sugar graphical user interface (GUI), and GNOME 

Interface (GNU Network Object Model Environment)  It also use  Mobile ad hoc networking via 802.11s Wi-

Fi mesh networking, to allow many machines to share Internet access as long as at least one of them could 

connect to an access point. 

XO Laptop has 4 different versions. 

These versions are: XO 1.0, XO 1.5, XO 1.75, and XO 4.0 

 

                                 XO LAPTOP 

 

9.1. XO laptop physical parts 

● Screen 

● Keyboard  

● Mouse  

The display functions in a full-color mode similar to other laptop displays and in an ultra-low-power, ultra-

high-resolution, black-and-white mode that is readable in direct sunlight.  

https://en.wikipedia.org/wiki/Quanta_Computer
https://en.wikipedia.org/wiki/One_Laptop_per_Child
https://en.wikipedia.org/wiki/Flash_memory
https://en.wikipedia.org/wiki/Hard_disk_drive
https://en.wikipedia.org/wiki/Fedora_Linux
https://en.wikipedia.org/wiki/Sugar_(GUI)
https://en.wikipedia.org/wiki/Graphical_user_interface
https://en.wikipedia.org/wiki/Mobile_ad_hoc_network
https://en.wikipedia.org/wiki/802.11s
https://en.wikipedia.org/wiki/Wi-Fi
https://en.wikipedia.org/wiki/Wi-Fi
https://en.wikipedia.org/wiki/Mesh_networking
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                                     PORTS  

Along with offering unique connectivity options, the XO laptop can work with a wide range of external 

devices.  

USB/memory ports  

The XO laptop features three external USB ports to support a variety of plug-in peripherals (one seen in the 

photo above, and two others under the other "ear"). 
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This is the XO battery. The battery attaches to the back of your XO.  

Keyboard and touchpad 

             

1. Escape-key  

The escape key is labeled with an × symbol on a black circle. The escape key is most commonly used 

in combination with the control key to quit activities (ctrl + esc).  

2. Tab-key  

The tab key is labeled with arrows pointing right and left and creates an indentation in a paragraph. 

Also, use it in combination with the control, shift and alt keys to display open Activities. For example, 

alt + tab displays running Activities one after the other.  

3. Control-key  

The control key is used in combination with other keys to issue commands. For example, ctrl + c 

copies to the clipboard; ctrl + v pastes from the clipboard.  

4. Shift key 
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The shift key is used in combination with other keys as a modifier, most commonly to shift between 

lowercase and uppercase in Latin-based alphabets.  

5. Fn-key  

The function key is used in combination with other keys as a modifier. For example, fn + erase is 

delete; fn + up arrow is page up. 

a) Alt key  :The alt key is used in combination with other keys to issue commands. For 

example, alt + enter toggles full-screen mode; alt + spacebar toggles the tray visibility. This 

example works in the Browse Activity but not in the Record Activity.  

b) Spacebar: The spacebar key types a space. In the future, when used in conjunction with the 

function key (fn), it will display the source code for the currently running Activity.  

c) Alt Gr key: The alt graphics key is used in combination with other keys as a modifier, most 

commonly to select an alternative letter or generate an accented character. For example, on 

the US keyboard, alt gr + j  creates a euro sign €; a + alt gr + 4 creates á.  

d) Arrow keys: The arrow keys are used for navigation; combined with the function key (fn), 

they are used for page up, page down, home, and end.  

e) Language key: The language key is found on keyboard layouts that combine Latin and non-

Latin scripts, going between scripts so that you can switch between typing in English and 

Hindi by pressing it. On Latin-only keyboards, the language key has been replaced by a × 

and ÷ key.  

f) Enter key: The enter key—in addition to its standard use—is used in combination with 

modifier keys. For example, alt + enter toggles full-screen mode.  

g) Erase key: The erase key deletes the character behind the cursor (backspace). fn + erase 

deletes the key in front of (or on) the cursor.  

h) Frame key: The Frame key toggles the presence of the Frame on the screen. The Frame is 

the black border around the screen that holds the Activity taskbar, clipboard, wireless 

connections, battery level, and so on.  

i) Volume controls: The volume keys lower and raise the audio level.  
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j) Brightness controls: The brightness keys lower and raise the brightness of the screen 

backlight. To turn the backlight off completely may take 7 to 8 button presses.  

k) View keys: The four view keys, from left to right, take you to the Neighborhood view, the 

Group view, the Home view, and the Activity view.  

l) Search key: The search key takes you directly to the Journal and places the text cursor in 

the search box.  

9.2. Software parts 

Software is a set of instructions, data or programs used to operate computers and execute specific tasks. It is 

the opposite of hardware, which describes the physical aspects of a computer. Software is a generic term used 

to refer to applications, scripts and programs that run on a device. XO laptop has 2 interfaces: Sugar interface 

and Gnome interface 

9.2.1. Sugar interface  

Sugar is a learning platform that reinvents how computers are used for education.  Collaboration, reflection, 

and discovery are integrated directly into the user interface. 

Sugar applications are called "Activities". Activities include an application as well as sharing and 

collaboration capabilities, a built-in interface to the Journal, and other features such as the clipboard.  

Sugar promotes “studio thinking” and “reflective practice”.  

 

Sugar facilitates sharing and collaboration.  

Children can write documents, share books and pictures, or 

make music together with ease.  
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Everything is saved automatically.  

It is our goal that you will never lose your work. Documents 

will eventually by sync with a network server, adding 

additional protection.  

 

a)  Typing turtle Activity 

In typing turtle, you learn to use keyboard in different levels: 

Kids learn typing method in fun way what I can call typing adventure. 

 

 

1) Space key and enter key 

2) Home row keys: a, s, d, f, g, h, j, k and l 

- Typing each letter 

- Exercise of typing pairs of letters 

- Exercise of combining two different letters 

- Exercise of writing words 

3) Home row balloons: is the practice of the home row keys in exciting game. 
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4) The top row key: q, w, e, r, t, y, u, i, o and p 

- Typing each letter 

- Exercise of typing pairs of letters 

- Exercise of combining two different letters 

- Exercise of writing words 

5) Top row balloons: is to practice the home and row key together by trying to pop all the balloons. 

6) The bottom row keys: z, x, c, v, b, n and m 

- Typing each letter 

- Exercise of typing pairs of letters 

- Exercise of combining two different letters 

- Exercise of writing words 

7) Alphabet balloons: the practice/or exercise of all alphabets/letters. This practice combines home 

row, top row and bottom row keys. 

8) Left hand capitals: after knowing all placement of the alphabet, it is time to get started with capital 

letters. This level 8 teaches you the capital letters which are typed by your left hand: Q, W, E, R, 

T, A, S, D, F, G, Z, X, C, V and B  

- Typing each letter 

- Exercise of typing pairs of letter 

- Exercise of combining two letters writing in capital and single 

- Exercise of writing words using all letters writing in capital and single 

9) Right hand capitals: after knowing all the placement of the alphabet, it is time to get started with 

capital letters. This level 8 teaches you the capital letters which are typed by your right hand: Q, 

W, E, R, T, A, S, D, F, G, Z, X, C, V and B  

- Typing each letter 

- Exercise of typing pairs of letters 

- Exercise of combining two letters writing in capital and single 

- Exercise of writing words using all letters writing in capital and single 
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10)  Capital balloons: practice of capital letters by popping some balloons 
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b)  Journal 

The Journal Activity is an automated diary of everything you do with Sugar. Sugar Activities use the Journal 

as a place to save your work. You can use the Journal as a place to revisit old work, to resume incomplete 

work, to organize your completed work, and to reflect upon your progress as a learner.  

To show the Journal, click the Journal icon on the Frame.  

● To delete in Journal 

You can delete only some contents in Journal 

● Way to delete in Journal 

Open Journal activity, Place your cursor on the icon of the activity you want to delete 

then press right click and click on Erase. 

● A Journal is used for accessing data.   

The Journal is a diary of things that you make and actions you take. It is a place to reflect upon  your work. 
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                     Journal icon 

 

 

 

Saving in internal and external 
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c) Write Activity 

The write activity serves as the document creation. It is simple interface provides an easy starting 

for children, presenting tools that make writing story, poem, or essay simple and straightforward. 

It also supports tools for inserting images, creating tables, and performing layout operations. 
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• Learn how to use XO Keyboard to write activity 

To write capital letter, making space and paragraph, deleting some special keys 

 

• Text formatting: Underline, Bold, Italic 
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• To make any change, make a selection 

 

• To Save and open a document 

- Before saving you can rename your work by replacing Write Activity by the name 

 

• To change color and size: 

    To change color: 

a. Select what you need to give a color 

b. Click on color button and it will show rectangular inside the window 
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• To change size 
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• To upload the picture in write: 

- Take the picture 

- Copy it to clipboard: Place the cursor o the picture in tray region and then it will display a pop menu. 

Through that, click on clipboard 

- Open write activity: in order to see its icon, back to home view 

- Reduce the screen in order to see the picture copied: click on  button up to Erase button 

- Drag and drop the photo (shown at the left of your window) inside your paper of write 

- Place the cursor where you want to start the comment and then start writing. 

• To insert a table 

 

• To upload a picture in write: 

- Take the picture 

- Copy it to clipboard: Place the cursor o the picture in tray region and then it will display a pop menu. 

Through that, click on clipboard 

- Open write activity: in order to see its icon, back to home view 

- Reduce the screen in order to see the picture copied: click on  button up to Erase button 

- Drag and drop the photo (shown at the left of your window) inside your paper of write 

- Place the cursor where you want to start the comment and then start writing. 



182 
 

                           

- Put the cursor in the first cell, Drag the cursor until you get desired table, then click on enter 

 

d) Paint Activity: 

Paint activity provides a canvas for an individual or a group of children to express themselves creatively 

through drawing. In paint activity we either draw using free hands or geometrical shapes. 

To open paint activity, we click on paint icon 

 

• Drawing Tools 

The paintbrush, pencil, and eraser are the primary freeform drawing tools. The sizes and shapes of the brush 

and eraser may be adjusted via their secondary palette, which is shown by hovering your mouse on the tool 

icon. 
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         How to select pencil (brush), rubber and basket?  

       
• Give a size to the pencil and color. 

 

Basket 

A basket is used to color a large closed area. 

To select the color, use the same process as in write activity. 

After selecting the color, choose the basket and place it on the suitable place then click. 

 

 

Theodore Ngendahayo
Leon will update it
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• Using geometrical shapes 

The Paint Activity has a toolbar dedicated to shape drawing. By clicking and dragging, you can create an 

instance of the currently selected shape and expand it to the size of your choosing. The interactive placement 

system makes the shape too even more powerful. Each shape has a secondary palette which allows various 

parameters to be set, such as the number of edges on a polygon, the number of points on a star, or the angles 

of a triangle. 

 

- Choosing a closed shape that you want. 

• Inserting image 

 

 Different shapes 
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- Choose the image that you want 

 

Click on the image you want 

• Renaming a picture 

 

9.2.2 Gnome interface 

GNOME   is a desktop environment and graphical user interface that runs on top of a computer operating 

system. It is composed entirely of free and open source software and is developed by both volunteers and paid 

contributors, the largest corporate contributor being Red Hat. It is an international project that includes 

creating software development frameworks, selecting application software for the desktop, and working on 

https://en.wikipedia.org/wiki/Desktop_environment
https://en.wikipedia.org/wiki/Free_and_open_source_software
https://en.wikipedia.org/wiki/Red_Hat
https://en.wikipedia.org/wiki/Software_framework
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the programs that manage application launching, file handling, and window and task management. 

 

• Switch from sugar to gnome: 

Click on my settings, 

 

  

                   

https://en.wikipedia.org/wiki/Application_launcher
https://en.wikipedia.org/wiki/File_manager
https://en.wikipedia.org/wiki/Window_manager
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• Gnome interface screen 
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• Gnome applications: 
a) Abiword 

 Abiword supports both basic word processing features such as lists, indents and character formats, and more 

sophisticated features including tables, styles, page headers and footers, footnotes, templates, multiple views, 

page columns, spell checking, and grammar checking. The Presentation view of Abiword, which permits easy 

display of presentations created in Abiword on "screen-sized" pages, is another feature not often found in 

word processors. 

• To open Abiword 

 

- Go to Gnome interface 
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• Identification of elements of Abiword window 

 

• Text formatting 

Font color, Font style, Font size, Underline style, Underline color, Font faces (Character. 

N.B: Before you make any change of text, make a selection 

Example:   Write some text 
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 Release the mouse click 

 

• To save your document 

                -     Click on File  

                           -      Choose Save As 
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b) Gnumeric spreadsheet 

Numeric is a spreadsheet, a computer program used to manipulate and analyze numeric data.  Numeric can 

help you keep track of information in lists, organize numeric values in columns and rows, perform and update 

complex calculations by defining each step of the calculation and modifying particular steps subsequently, 

create and display or print graphical plots of data using bar plots, line graphs, pie charts or radar charts, 

implement complex optimization modeling or perform many other tasks involving numbers, dates, times, 

names or other data.  
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After Click to Spreadsheet, you get this window: 

 

 

The part names are listed below along with a reference to the section that discusses that element. If you are 

reading this document on a computer, you may be able to click on a reference to jump to that section of the 

manual.  

● The menu bar:  provides access to the core functions of GNOME. Almost everything that you can 

do in Numeric you can do through the menus. We discuss the menus and menu bar in  

● The standard toolbar:  provides shortcuts for the most used items in the menus. We discuss the 

toolbars and this toolbar in particular  

● The format toolbar: changes the display properties of data in the workbook.  

● The data entry area: is useful for the modification of complex formulas.  
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● The cell grid area: lies in the middle of all the rest. The cell area includes the row and column labels, 

the scrollbars and the tabs below.  

• Mathematical operators. 

                                   Using the sum function in spreadsheet : 

 

 

 

http://www.wikihow.com/Use-the-Sum-Function-in-Microsoft-Excel
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- Press enter. Spreadsheet will add up the numbers in cells C5 to E5 

               

9.4. Practice 

 

 

 

 

ACTIVITY 9.1. 

1. How many interfaces does the XO Laptop have? 

2. If you want to save a document, you click on: a) Insert     b) File        c)Open 
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MODULE 10: PROGRAMMING FOR CHILDREN  

Programming is the art of writing instructions to tell a computer what to do. A set of instructions is called a 

program. The instructions are written in what’s known as a programming language, and there are thousands 

to choose from. 

10.1.  Scratch activity 

Scratch is a programming language that is perfect for making games, animations, interactive stories and 

other visually rich programs. 

a) Basic Ingredients of a scratch project  

● Scratch projects are made up of objects called sprites. 

● You can change how a sprite looks by giving it a different costume.  

● You can make a sprite look like a person or a train or a butterfly or anything else.  

● You can use any image as a costume: you can draw an image in the paint editor, import an image from 

your hard disk, or drag in an image from a website.  

● You can give instructions to a sprite, telling it to move or play music or react to other sprites.  

● To tell a sprite what to do, you snap together graphic blocks into stacks, called 

scripts. When you double-click on a script, Scratch runs the blocks from the top of the script to the 

bottom. 

b) Get started with scratch    

● click on the scratch icon  

● click start to open scratch activity  
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c) Scratch interface: 

 

• Stage  

The Stage is where you see your stories, games, and animations come to life. Sprites move and interact with 

one another on the stage. The stage is 480 units wide and 360 units tall. It is divided into an x-y grid. The 

middle of the stage has an x-coordinate of 0 and a y-coordinate of 0. 
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• New sprite button   

When you start a new Scratch project, it begins with a single cat sprite. To create new sprites, click on these 

buttons: 

 

If you want to delete a sprite, select the scissors from the Toolbar and click on the sprite. Or right-click on the 

sprite and select “delete” from the pop-up menu. 

• Sprite list  

The Sprite List displays thumbnails of all of the sprites in the project. For each sprite, it shows the sprite’s 

name, how many scripts it has, and how many costumes it has. 

 

To see and edit a sprite’s scripts, costumes, and sounds, click on the sprite’s thumbnail in the Sprite List – or 

double-click on the sprite itself on the Stage. (The selected sprite is highlighted and outlined in blue in the 

Sprite List.)  

To show, export, duplicate, or delete a sprite, right-click (Mac: Ctrl+click) on the sprite’s 

thumbnail in the Sprite List. To show a sprite that is of the Stage or hidden, Shift click 
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on the sprite’s thumbnail in the Sprite List - this will bring the sprite to the middle of the 

Stage and show it. You can rearrange the sprites in the Sprite List by dragging the thumbnails. 

Just as a sprite can change its appearance by switching costumes, the Stage can change 

its appearance by switching backgrounds. To see and edit the scripts, backgrounds, and 

sounds associated with the Stage, click on the Stage icon at the left of the Sprite List. 

• Block palette and scripts area 

To program a sprite, drag blocks from the Blocks Palette to the Scripts Area.. 

Create scripts (programs) by snapping blocks together into stacks. Click anywhere on the 

stack to run the whole script, from top to bottom. To find out what a block does, right-click (Mac: Ctrl+click) 

on it, then select help from the popup menu. 

When you drag a block around the Scripts Area, a white highlight indicates where you can 

drop the block and form a valid connection with another block. 

To move a stack, pick it up from the top block. If you drag out a block from the middle of a 

stack, all of the blocks beneath it will come along with it.  

Some blocks have white editable text files inside, such as .  

To change the value, click inside the white area, delete the existing number, and type a new number. You can 

also drop rounded blocks, like  , inside these areas.Some blocks have pull-down menus, such as 

. Just click on the to see the menu, and then click again to make a selection.                          

• Costumes  

Click the Costumes Tab to see and edit the sprite’s costumes. 

This Sprite has two costumes. The sprite’s current costume (girl-walking) is highlighted. To 

switch to a different costume, simply click on the thumbnail of the costume you want. 
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There are four ways to create new costumes: 

● Click  to paint a new costume in the Paint Editor. 

● Click  to import an image file from your hard disk. 

● Click  to take photos from a webcam (built into or connected to your 

computer).Each time you click the button (or press the spacebar), it takes a photo. 

●  Drag in one or more images from the web or your desktop. 

Scratch recognizes many image formats: JPG, BMP, PNG, GIF (including animated GIF). 

Each costume has a costume number (displayed to its left). You can rearrange the order of the 

costumes by dragging the thumbnails. The costume numbers update if you change their order. 

Right-click (Mac: Ctrl+click) on a costume thumbnail to convert the costume into a new sprite, 

or to export a copy of the costume as a separate file.  

• Sounds 

● Click the Sounds Tab to see the sprites sounds. 
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You can record new sounds and import sound files. Scratch can read MP3 files and uncompressed WAV, 

AIF, and AU files (encoded with 8-bits or 16-bits per sample, but not 24-bits per sample). 

• Current Sprite info  

 

 

Current Sprite Info shows a sprite’s  

● Name,  

● x-y position,  

● And direction. 

You can type in a new name for the sprite. 

The sprite’s direction indicates which direction the sprite will move when it runs a move block (0=up, 

90=right, 80=down, -90=left).  

The blue line on the thumbnail shows the sprite’s direction. You can drag this line to change the sprite’s 

direction.  

Double-click on the sprite to set the direction back to its original state (direction=90). 
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Click Export Sprite to save the sprite as a separate file, for use in another project. 

• Rotation style  

Click the Rotation Style buttons to control how the costume rotates as the sprite changes its direction. 

Rotate: The costume rotates as the sprite changes direction.  

Left-right flip: The costume faces either left or right.  

No-rotate: The costume never rotates (even as the sprite changes direction) 

Toolbar 

 

 

                                                MENU 

 

● New, Open, Save, and Save as do what you would expect them to do. 

● Share! Uploads your project to the Scratch website (http://scratch.mit.edu) 

● Undo allows you to retrieve the last block, script, or sprite you deleted (but does not allow you to undo 

most other actions). 

 

Language allows you to select the language used on the Scratch blocks. (For now, the menu items 

and tabs are available only in English.) 

http://scratch.mit.edu/
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● Extras give a pop-up menu with special features: 

● Import Project: Bring all of the sprites and backgrounds from another project into this project. This 

feature is useful for combining sprites from multiple projects. 

● Start Single Stepping: The Scratch program runs one step at a time, highlighting each block as it 

runs. This feature can be useful for finding bugs in programs, and for helping new programmers 

understand the flow of a program. 

● Compress Sounds: Compress sounds used in the project, to reduce the overall fie size of the project. 

● Compress Images: Compress images used in the project, to reduce the overall fie size of the project. 

● Want Help? Brings up a page with links to reference materials, tutorials, and frequently asked 

questions. To get help on an individual block, right click on the block and select help from the pop-up 

menu. 

d)  Block descriptions  

The Scratch blocks are organized into eight color-coded categories. 

These categories and their functions in Scratch project are:. 

● CONTROL: Use for controlling the blocks within your spirits. 

● MOTION: Use to move sprits in the stage. 

● LOOKS: Use for display text. 

● SENSING: They let you identify what’s happening at a given point and make your sprites or 

background respond. 

● SOUND: Use for import sound in the scratch project. 

● OPERATORS: Let you make comparisons between or perform arithmetic functions on different 

values. 

● PEN: Use for writing in scratch project 

● VARIABLE: Let you define values for a variable and then use it in your project. 
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10.2. Turtle art activity  

Turtle Art is a free, web-based coding platform that lets you make artistic designs and share your code 

sequences and images with friends. 

Turtle Art allows students to use mathematical reasoning, problem solving, counting, measurement, geometry 

and computer programming to create beautiful images. 

Play with Turtle Art to draw colorful art patterns using a turtle that accepts instructions for  

movement. 

With visual programming blocks, you can snap together programs by compiling (combining) them in ways to 

create anything you can imagine. 

This is a turtle icon in sugar interface 
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                                     The Turtle Window

 

• Elements of Turtle Art Window  

The Turtle Art window has the following elements.  

Main Toolbar the Main toolbar consists of the following tools: 
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1. Activity toolbar (includes sharing; saving/loading options);  

2. Edit toolbar (includes copy and paste);  

3. View toolbar (includes full-screen, coordinate overlays and turtle status);  

4. Palette toolbar (includes all programming blocks);  

5. Erase canvas;  

6. Run project fast (rabbit);  

7. Run project slow (snail);  

8. Hide blocks (This button is replaced by the stop button when the project is running);  

9. Help; 

10. Load examples;  

11. Stop activity 

• Palettes Toolbar  

To get the Palettes toolbar, click on the Block icon on the Main toolbar. 

 

 The palettes toolbar consists of the following palettes: 

1. Turtle Palette  

2. Pen Palette  

3. Color Palette  

4. Numbers Palette  

5. Flow Palette 

6. Blocks Palette  

7. Sensors Palette  

8. Media Palette 
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9. Extras Palette  

10. Portfolio Palette  

11. Trash Palette 

12. Numbers Palette  

13. Media Palette 

Each palette consists of blocks. A block is a command for the turtle. For example, there is a block to tell the 

turtle to go forward. 

You can add blocks to your program by clicking on or dragging them from the palette to the main area. You 

can also delete a block by dragging it back onto the palette 

 

Pen Palette  

Blocks available in the Pen palette are used to control the attributes of the Turtle’s pen. 

 

Color Palette  

Blocks available in Color palette can be used with the set-pen-color block in place of a number block. 
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Flow Palette Blocks  

Available in Flow palette control the program flow. 

 

• Using Turtle Art Instructions/Commands  

Here are some instructions you can use in Turtle Art.  

(a) Forward: Using this command, you can move the turtle forward with the number of pixels entered. 
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• Drawing  

Using multiple blocks from the Turtle palette, we can draw lines (horizontal and vertical), square, rectangle 

and circle. 

To draw a vertical line:  

1. Move the turtle forward 100 spaces 

 2. To make the line longer change 100 to 400 

 

To draw a horizontal line:  

1. Turn the turtle right 90 degrees.  

2. Then move the turtle forward 100 spaces. 
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To draw an oblique line:  

1. Turn the turtle right 60 degrees.  

2. Then move the turtle forward 100 spaces. 

 

To draw a rectangle: 

 

To draw a rectangle: 

 

 

To draw a circle 

 Arc the turtle right 360 degrees with radius 100 spaces. 
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Using the Repeat command  

The repeat command helps you to avoid writing the same commands several times. When you use the Repeat 

command you should also use the command written on Start. 

 

Any commands that are attached to the repeat will be repeated the number of times specified 

by the number on the top. 

This example draws a circle then picks up the pen, moves forward 10 spaces then turns right 90 

Degrees. This command repeats 4 times. 

Square with repeat instructions 

 

 10.3. Etoys activity 

Etoys is a child friendly computer environment and object-oriented prototype-based programming language 

for use in education. Etoys is a highly engaging programming environment that etoys lets you create 

interactive drawings and stories, models, simulations and games with text, graphics, and sound. This lets you 

explore ideas and learn by doing. With a drag and drop interface. The etoys home screen is the main project 

page you see when you open an etoys project. It is basically a playfield. 
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                                               Screen of etoys 

 

Etoys home page is composed of: 

● Toolbar 

● Three Clouds (Gallery of projects, Make a project, Tutorials and Demos 

● A running car 

● An open Scripts 

● The toolbar at the top of the screen includes basic navigation through Etoys. Each of these has a balloon 

help bubble that pops up if you hover over any item. 
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Tutorials and Demos: In this section you'll see three demos, of increasing difficulty. We recommend that if 

you are new to etoys, you start here 

 

 

Gallery of Projects: If you want to see examples of what you can do with etoys, look at the various models 

shown here. 

 

Make a Project: When you click on this cloud, you will see a blank screen. At the top is your menu. You'll 

even see two calls out bubbles giving you two places to start. If you hover over any item, you will see a call 

out bubble describing what that item does. This is a simple Project you can do in etoys 
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 To create a book 

The BOOK is one of the most useful objects in etoys. You can use it to do Slideshows, class diaries and albums; 

register observations and even create your own animated book. The most interesting is that you can insert any 

kind of element (OBJECT) inside a BOOK. For example, you can add text, drawings and even animations in 

order to bring your book to live. 

  Steps to create a book 

                            Click on supplies 

                                                             

1. Once etoys is open, you can find the BOOK in the SUPPLIES box 

2. When the SUPPLIES box opens, you will see the BOOK icon, 

 

 

 

3. Now, just drag the BOOK icon over the SCREEN to create a new book 
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Adding Text to the Book 

It is also very easy to add some text to the book. What we need to do is to open again our SUPPLIES box and 

look for the TEXT object. 

                                                

Drag the TEXT over the book, and drop it. To start writing, just select the text and start typing. 

To change the font or the size of your text. What we need to do is to call the halo, by right clicking the TEXT. 

Resize the page of the book by using resize tool  

                                  

Now you can add the pages on the book 

Adding drawings to the Book 

There are two ways of adding a drawing to the BOOK. If you already have a drawing outside the book, just 

drag it and drop over the book. The drawing will be automatically added to the current page. The second way 

is to create a new drawing, by clicking the PAINT icon  on the top menu. 
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When you click on the paint palette in the toolbar, the painting tool will appear and part of the screen is 

covered with a transparent rectangle. This is your drawing sheet. If you want to draw several objects, exit the 

painting tool by clicking “keep”. 

Painting a background 

The BOOK is often used to create stories with animated characters. But in order to do animations in etoys, it 

is necessary to draw the scenario (BACKGROUND) separated from the characters (OBJECTS). 

 

In the navigator tab,  click on the“Publish” icon. A form will appear. Using the form, name the project. 

 

 

After you click “ok” on the form, a 

new window will appear. Click once 

on “Etoys” 
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Z 

10.4  Practice 

  

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ACTIVITY.10. 1 

Interactive art 

Write these script to the sprite One     

 

 

ACTIVITY10.2. 

Animation 

Air plane animation 

Input Block Script to the Air Plane                             

The Output will look like this 
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ACTIVITY 10.3. CREAT A DIALOGUE 

    Suggested answer  

Scripts to create a dialogue: Paul and Peace 

 

Scripts for Paul 

 

Scripts for Peace 
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